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                               Αρχικοποίηση Περιβάλλοντος  
 
 
Τα αρχεία εγκατάστασης πρέπει να αντιγραφούν στο home directory πριν ξεκινήσει τη λειτουργία 
του το cadence. Αυτό για λόγους ευκολίας έχει παραληφθεί απ’τη διαδικασία που πρέπει ο χρήστης 
να ακολουθήσει και οι εντολές που χρειάζονται για να τρέξει το πρόγραμμα και να φορτωθούν οι 
κατάλληλες βιβλιοθήκες γίνεται αυτόματα. Το μόνο που πρέπει να κάνει ο χρήστης είναι να  
δημιουργήσει ένα φάκελο στον οποίο θα αντιγραφούν τα setup files και μέσα εκεί να εκτελέσει την 
εντολή icfb&. 
 
 
 
 
1.    Ξεκινώντας το πρόγραμμα Cadence  
 
Όταν θα είστε έτοιμοι να τρέξετε το πρόγραμμα Cadence τοποθετήστε τον κέρσορα στο τελικό 
παράθυρο ( Terminal window ) στο οποίο είχατε κάνει loggin, μπαίνεται στο κατάλληλο directory 
που θέλετε να δουλέψετε και είχατε δημιουργήσει εσείς και πληκρολογήστε icfb&. Αυτό θα έχει ως 
αποτέλεσμα να ξεκινήσει το Cadence design software. Αν όλα λειτουργούν σωστά, θα δείτε να 
εμφανίζεται στην οθόνη σας ένα παράθυρο εκκίνησης παρόμοιο με αυτό που ακολουθεί. 
 
 
 
 

                    
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
Μόλις κλείσει το παράθυρο εκκίνησης , ανοίγει ένα άλλο παράθυρο σαν το παρακάτω. Το παράθυρο 
αυτό ονομάζεται Command Interpreter Window ( CIW ) - Παράθυρο Διερμήνευσης Εντολών. 
 
      
 

 
 
 
Το παράθυρο αυτό αντιπροσωπεύει το περιβάλλον Design Framework II και παρέχει πρόσβαση 
στο Cadence μέσω των μενού που διαθέτει, ή μέσω της γραμμής εισόδου χρησιμοποιώντας SKILL 
εντολές. Το CIW παράθυρο αποτελεί το παράθυρο ελέγχου για το πρόγραμμα Cadence. 
 
 
 
 
1.1   Ανοίγοντας και Χρησιμοποιώντας το Library Manager 
 
Ένας από τους πιο απλούς τρόπους να πλοηγηθείς μέσα στις βιβλιοθήκες ( σ'αυτές που περιέχει 
ενσωματωμένες το Cadence και σ'αυτές που έχετε δημιουργήσει εσείς ) είναι χρησιμοποιώντας το 
Library Manager. Μια βιβλιοθήκη είναι μια συλλογή απο cells, όπως NOT, AND, NAND κτλ. 
Μέχρι το τέλος του εξαμήνου, θα πρέπει να γνωρίζετε τις αναπαραστάσεις  απ'τις περισσότερες 
πρωταρχικές πύλες ( primitive gates ) και μερικών σύνθετων κελιών  ( complex cells). Οι τελευταίες 
πύλες περιλαμβάνουν αρκετές απόψεις αναπαράστασης, συμπεριλαμβανομένων το schematic, 
layout, extracted, symbol κτλ. 
 
Κάποιες επιπλέον συμβάσεις που θα χρησιμοποιηθούν είναι οι παρακάτω : 
 
Κάντε κλικ στο CIW: Tools - Library Manager  -- Αυτό σημαίνει ότι πηγαίνω στο CIW 
παράθυρο, κάνω αριστερό κλικ στο Tools κι έπειτα  κάνω ξανά αριστερό κλικ στην επιλογή Library 
Manager στο αναδυόμενο μενού που θα εμφανιστεί. 
 
Κάντε κλικ στο CIW: Tools - Library Manager. Θα ανοίξει ένα παράθυρο σαν το ακόλουθο 
 



 
 
 
 
 
Η αριστερή στήλη είναι μια λίστα με τις τρέχουσες βιβλιοθήκες. Απ'αυτές τις βιβλιοθήκες η πιο 
σημαντική είναι η analogLib. Αυτή η βιβλιοθήκη περιέχει όλα τα στοιχεία που χρειάζονται κατά τη 
σχεδίαση ενός vlsi κυκλώματος. Επίσης βλέπουμε τη βιβλιοθήκη umc90nm και θα είναι αυτή που 
θα χρησιμοποιηθεί περισσότερο από εμάς κατά την κατασκευή κυκλωμάτων.  
Κάντε αριστερό κλικ στο umc90nm στο library browser.  
Κάντε αριστερό κλικ στο Ν_10_SP για να εμφανιστούν οι διαφορετικές αναπαραστάσεις σχεδίασης 
του nmos τρανζίστορ. 
Οι αναπαραστάσεις των cells περιλαμβάνουν την παρακάτω πληροφορία : 
 
symbol - περιλαμβάνει τη συμβολική αναπαράσταση του schematic 
hspiceD, spectre,  -περιλαμβάνει spice πληροφορία για το στοιχείο. 
 
Μπορείτε μόνοι σας να κοιτάξετε για οποιαδήποτε αναπαράσταση κάθε cell . Για να το κάνετε αυτό, 
κάντε κλικ και κρατήστε πατημένο στην αναπαράσταση που θέλετε ( cell view ) και επιλέξτε read ή 
κάντε διπλό κλικ σε μια συγκεκριμένη αναπαράσταση , αυτή που σας ενδιαφέρει. Θα εμφανιστεί 
ένα παράθυρο που θα σας δείχνει τα περιεχόμενα του τρέχοντος παραθύρου. 
Σε διαφορετικά κελιά μπορεί να εμφανιστούν και οι παρακάτω αναπαραστάσεις: 
 
abstract  - περιέχει μια αφαιρετική αναπαράσταση του layout  
 



Extracted - περιλαμβάνει συνδεσιμότητα layout και χρησιμοποιείται από προγράμματα 
επαλήθευσης 
 
Layout - περιλαμβάνει την αναπαράσταση του τρανζίστορ σε επίπεδο πυριτίου και καλωδίωση ( θα 
ασχοληθείτε αρκετά μ'αυτό ) 
 
schematic - περιλαμβάνει το λογικό σχεδιασμό αυτού που θέλουμε να σχεδιάσουμε 
behavioral  - περιλαμβάνει τη VHDL περιγραφή του cell  
 
Εγκαταλείποντας το παραπάνω τμήμα 
Κάντε κλικ στο CIW : File  -  Quit 
 
Θα εμφανιστεί ένα παράθυρο διαλόγου, που θα σας ζητάει να επιβεβαιώσετε το αίτημά σας. Κάντε 
κλικ στο ΟΚ για να εγκαταλείψετε το Cadence, ή κάντε κλικ στο Cancel για να ακυρώσετε τη 
διαδικασία. Αν έχετε ξεχάσει να αποθηκεύσετε τη δουλειά σας, θα εμφανιστεί μια φόρμα 
αποθήκευσης του cell view με τα ονόματα των cell, cell view και της βιβλιοθήκης . Αφού έχετε 
κάνει όλες τις απαραίτητες επιλογές κάντε κλικ στην επιλογή ΟΚ. Όλα τα παράθυρα του Cadence 
τώρα θα κλείσουν  και το τμήμα σχεδίασης θα τελειώσει. 
 
 
 
1.2  Δημιουργία μιας Νέας Βιβλιοθήκης 
 
Για να δημιουργήσετε μια νέα βιβλιοθήκη κάντε κλικ στο CIW : Tools - Library Manager και θα 
ανοίξει το παράθυρο του library manager. 
Επιλέξτε Library Manager : File  -  New  -  Library ώστε να ανοίξει ένα καινούριο παράθυρο σαν 
κι αυτό που ακολουθεί :  
 
 
 

                                          



 
 
Εισάγετε το όνομα της βιβλιοθήκης που θέλετε να δημιουργήσετε και επιλέξτε ΟΚ. Το σύστημα σας 
ενημερώνει για το αν ένα technology file θα προστεθεί στη βιβλιοθήκη.  
Η προεπιλεγμένη επιλογή είναι " compile a new techfile". Αλλάξτε την σε " Attach to an existing 
techfile" και επιλέξτε ΟΚ. Το σύστημα σας ενημερώνει για το techfile που πρόκειται να επισυνάψει 
στο αρχείο βιβλιοθήκης. 
 
 

                                      
 
 
 
Επιλέξτε για το πεδίο Technology Library τη βιβλιοθήκη umc90nm όπως φαίνεται παρακάτω. 
Επιλέξτε ΟΚ. 
 
             
 
            

                             
 
                                 
 
Πλέον , η νέα σας βιβλιοθήκη , στη περίπτωση αυτή η MyDesignLib, θα εμφανίζεται στο Library 
Manager όπως φαίνεται στο ακόλουθο παράθυρο. 
 
 
 



       
 
 
 
 
1.3   Άνοιγμα ενός ήδη υπάρχοντος αρχείου Schematic 
 
 
Επιλέξτε CIW : File  -  Open 
Θα εμφανιστούν δύο παράθυρα διαλόγου : το ένα απ'αυτά είναι το Open File και το άλλο το 
Library Browser 
 
To Library Name, το Cell Name και το Cell View επιλέγονται από το Library Browser ώστε οι 
αλλαγές να εφαρμοστούν και στο παράθυρο Open File ή μπορούν κατευθείαν να εισαχθούν στο 
Open File παράθυρο. 
 
 
 
 
 
 
 
 
 
 



1.4   Δημιουργία ενός Νέου Schematic 
 
Επιλέξτε CIW : File  -  New  -  CellView στο Library Manager
 
Ένα παράθυρο διαλόγου θα εμφανιστεί για να δημιουργήσετε ένα νέο cell view 
 
 

                                       
 
 
 
Tο πεδίο Library Name θα περιέχει το όνομα της Νέας Βιβλιοθήκης που έχει δημιουργηθεί ( εδώ 
MyDesignLib) . Άν πρόκειται να σχεδιάσετε έναν αντιστροφέα τότε στο πεδίο cell Name δώστε το 
όνομα " myInv ". Άν θέλετε να σχεδιάσετε το schematic του αντιστροφέα , τότε δώστε ως όνομα 
στο πεδίο View Name το "schematic" και από το μενού Tool επιλέξτε Composer - Schematic.  
Επιλέξτε ΟΚ και θα εμφανιστεί ένα κενό παράθυρο Composer – Schematic. 



 
 
 
 
 
1.5   Εισάγοντας στοιχεία στο Schematic 
 
Για να σχεδιάσετε έναν αντιστροφέα , πρέπει να προσθέσετε PMOS και NMOS τρανζίστορς , 
γειώσεις , τροφοδοσία , εισόδους, εξόδους και να τα ενώσετε όλα αυτά με καλώδια. 
 
Στο σημείο που βρίσκεστε θα πρέπει να είναι ανοιχτό το Composer-Schematic παράθυρο (Virtuoso 
Schematic Editing ).  Κάντε κλικ στο Virtuoso Schematic Editing : Add  -  Instance.  Θα ανοίξει 
μία Add Instance φόρμα όπως φαίνεται στη συνέχεια. Επιλέξτε Browse και θα εμφανιστεί το 
Library Browser – Add Instance παράθυρο.  
 



                           
 
 
 
 

                                     
 
 
 
Στο Library Browser επιλέξτε umc90nm στο Library, N_10_SP στο Cell για τα NMOS τρανζίστορς 
και P_10_SP για τα  PMOS τρανζίστορς και symbol στο View. 
Πατήστε close στο παράθυρο Library Browser . 
Θα πρέπει να έχετε στην οθόνη σας το παρακάτω  Add instance  παράθυρο για κάθε μια από τις 
παραπάνω περιπτώσεις . 
 
          
 
 
 
 
 
 



                 
 
 

                



 
Μη ξεχάσετε στη περίπτωση του pmos transistor να βάλετε διπλάσιο πλάτος ( 4u ) από αυτό που 
έχει το nmos transistor ( 2u ) , όπως δηλαδή απεικονίζουν και οι παραπάνω φόρμες. 
 
Μετακινήστε το κέρσορα πάνω απ'το παράθυρο, θα διαπιστώσετε πως ο κέρσορας εμφανίζεται σαν 
ένα nmos ή pmos τρανζίστορ .  Το τρανζίστορ μπορεί να τοποθετηθεί στην απαιτούμενη περιοχή με 
ένα αριστερό κλικ του ποντικιού. (Μπορείτε να τοποθετήσετε οποιοδήποτε αριθμό απο τρανζίστορς, 
σε οποιαδήποτε περιοχή θέλετε). Αν θέλετε να περιστρέψετε το στοιχείο σας πατήστε το πλήκτρο 
"r".  
 
Με τον ίδιο τρόπο τοποθετείτε στο schematic την τροφοδοσία και  τη γείωση . Για να συμβεί αυτό , 
στο παράθυρο Componenet – Browser επιλέξτε τη βιβλιοθήκη analogLib και στη συνέχεια 
βρίσκετε τα vdd και gnd και τα τοποθετείτε στις κατάλληλες θέσεις στον αντιστροφέα σας. Τα 
ονόματα αυτά είναι Global και δε χρειάζεται να τα ονοματίσετε εσείς. Αν έχετε κάνει κάποιο λάθος 
και πρέπει να τερματίσετε από το παράθυρο Add Instance , πιέστε το πλήκτρο Esc. Mέχρι στιγμής , 
θα πρέπει να έχετε μπροστά σας σε παράθυρο το schematic όπως φαίνεται στη συνέχεια. 
 
 
 
 

 
 
 
 
 
 



Αφού έχετε δημιουργήσει κι έχετε τοποθετήσει όλα τα στοιχεία που είναι απαραίτητα, μπορείτε να 
τα συνδέσετε με καλώδια ώστε να σχηματιστεί ο αντιστροφέας. 
 
Από το Composer – Schematic  παράθυρο, επιλέξτε Add - > Wire ( narrow ). 
  
Αρχικά κάντε κλικ στην αρχή απ'όπου θα ξεκινάει το καλώδιο ( source ) και ξανακάντε κλικ εκεί 
όπου θα τελειώνει (destination). Αν θέλετε να τοποθετήσετε περισσότερα καλώδια απλά κάνετε 
περισσότερες φορές αριστερό κλικ με το ποντίκι σας . 
 
Αφού έχετε καλωδιώσει σωστά το κύκλωμά σας , πρέπει να τοποθετήσετε pins για τους κόμβους 
εισόδου και εξόδου. 
 
Από το Composer – Schematic  παράθυρο, επιλέξτε Add - > Pin . Στη συνέχεια εμφανίζεται μία 
Add Pin φόρμα.  
Δημιουργείστε τα  Pin Names (πχ. ‘A Y’, ‘A X’, ‘X Y’, κτλ) , και σιγουρευτείτε πως το Direction 
είναι ‘input’, όπως φαίνεται στη συνέχεια. 
 
 
 

                     
 
 
 
Μετακινήστε το κέρσορα στο παράθυρο Schematic. Στη συνέχεια κάντε αριστερό κλικ με το 
ποντίκι ώστε να τοποθετήσετε το pin ‘A’. 
 
Ξαναμεταφέρετε το κέρσορα στη φόρμα  Add Pin  και αλλάξτε το Direction από ‘input’ σε 
‘output’ και ξανακάνετε ό,τι κάνατε για να τοποθετήσετε το pin A. 
 
Μετά το πέρας όλων των παραπάνω διαδικασιών, της τοποθέτησης των στοιχείων, της προσθήκης 
των pins και της καλωδίωσης , η σχηματική αναπαράσταση του αντιστροφέα θα μοιάζει με την 
ακόλουθη . 
 



 
 
 
 
Θυμηθείτε να αποθηκεύσετε το αρχείο επιλέγοντας Design -> Check and Save από το Composer-
Schematic  παράθυρο. Ο Composer θα ελέγξει για τυχόν λάθη όπως κόμβους στον αέρα (hanging 
nodes) και το μήνυμα λάθους θα εμφανιστεί στο CIW παράθυρο. Αν δεν υπάρχουν καθόλου λάθη  
το schematic θα αποθηκευτεί και θα εμφανιστεί ένα μήνυμα που θα ενημερώνει για την αποθήκευση 
χωρίς κανένα λάθος. 
 
 
 
1.6  Δημιουργώντας  Symbol View  
 
Πρέπει να δημιουργηθεί ένα σύμβολο για το schematic που έχει σχεδιαστεί έτσι ώστε σε μελλοντικά 
σχέδια , ο αντιστροφέας που έχει σχεδιαστεί παραπάνω, να χρησιμοποιείται ως αυτόνομο στοιχείο ( 
module ).  
 
Επιλέξτε Vistuoso File -> New -> Cell view στο Library Manager  και επιλέξτε τη επιθυμητή 
βιβλιοθήκη ώστε να δημιουργήσετε μέσα το νέο cell view. 
 
Τοποθετήστε ως Cell Name το myInv αν δεν το έχει ήδη και ως View Name πρέπει να 
πληκτρολογήσετε το όνομα  symbol . Ελέξτε επίσης αν στο Tool είναι το Composer – Symbol και 
στη συνέχεια αν όλα είναι όπως πρέπει επιλέξτε ΟΚ.  
 



                                         
 
 
 
 
Στο Composer-Schematic  παράθυρο επιλέξτε Design – Create Cellview – From Cellview και 
ανοίγει το ακόλουθο παράθυρο ώστε να δημιουργήσετε εσείς νέο σύμβολο για τον αντιστροφέα. 
 
 
 
 

              
 
 
Επιλέξτε ΟΚ και θα εμφανιστεί το σύμβολο όπως ακριβώς φαίνεται στη συνέχεια. 
 
 

                                                         
 



 
Επιλέξτε Check and Save . Το σύστημα θα κάνει έναν έλεγχο ανάμεσα στο σύμβολο και τη 
σχηματική αναράσταση (schematic) για να διαπιστώσει αν τα ονόματα των pins και οι συνδέσεις  
ταιριάζουν απόλυτα. 
 
 
 
 
2.  Simulation στο Spectre χρησιμοποιώντας το Analog Design 
Environment 
 
Στο σημείο αυτό θα εξηγήσουμε πως εξομοιώνουμε το κύκλωμα. Στη περίπτωση εδώ του 
αντιστροφέα, χρησιμοποιείται το Virtuoso Analog Design Environment. 
 
2.1  Δημιουργώντας ένα Test Bench 
 
Για να εξομοιώσετε αντιστροφείς , θα πρέπει να δημιουργήσετε ένα test bench με το cell του 
ονοματισμένο ‘myInv_test’ στη βιβλιοθήκη MyDesignLib. Στο schematic αυτό υπάρχουν ένας 
αντιστροφέας, τροφοδοσία, πηγή εισόδου και γείωση και όλα αυτά θα ελεγχθούν για την transient 
απόκρισή τους. 
 
Ξεκινάμε τη διαδικασία δημιουργώντας ένα νέο αρχείο όπως κάναμε παραπάνω , και δίνουμε τα 
κατάλληλα ονόματα και ορίσματα στα πεδία. Δημιουργούμε ένα νέο schematic view με όνομα 
myInv_test. 
 
 

                                       
 
 
 
 
Στη συνέχεια, από το παράθυρο Composer – Schematic , εισάγουμε το σύμβολο ‘myInv’ που είχαμε 
φτιάξει προηγουμένως ή έχουμε βρεί σε κάποια έτοιμη βιβλιοθήκη. 
 



 
 
 
 
Επιλέγουμε στη συνέχεια την πηγή εισόδου , την τροφοδοσία , τη γείωση και τον πυκνωτή , από τη 
βιβλιοθήκη analogLib δίνοντας τιμές που θέλουμε εμείς για την εξομοίωσή μας στα κατάλληλα  
πεδία των παραθύρων που εμφανίζονται σε κάθε περίπτωση, όπως φαίνεται στη συνέχεια. 
 
 
                              
 
 
 



                                
 
 
 



                            
 
 
 
Πατήστε Esc για να φύγετε από τη λειτουργία Add Instance. Συνδέστε με καλώδια τα στοιχεία 
μεταξύ τους , όπως φαίνεται στο σχήμα παρακάτω. 



 
 
 
 
Έχει πλέον κατασκευαστεί το κύκλωμα που θα τεσταριστεί. 
 
 
Θυμηθείτε να αποθηκεύσετε το αρχείο, επιλέγοντας Design -> Check and Save στο Composer – 
Schematic  παράθυρο. 
 
 
2.2  Εξομοιώνοντας το κύκλωμα με το Τυπικό Μοντέλο  
 
Για να εξομοιώσετε το κύκλωμα στη περίπτωση αυτή , θα πρέπει να ακολουθήσετε τη παρακάτω 
διαδικασία. 
 
Στο Composer – Schematic  παράθυρο , επιλέξτε Tools -> Analog Environment. Θα εμφανιστεί το 
παράθυρο Virtuoso Analog Design Environment όπως φαίνεται στη συνέχεια. 
 



            
 
 
 
 Στο Virtuoso Analog Design Environment παράθυρο , επιλέξτε Setup -> 
Simulator/Directory/Host. Θα εμφανιστεί το  Choosing Simulator/Directory/Host  παράθυρο . 
Επιβεβαιώστε πως το Simulator βρίσκεται στη κατάσταση ‘spectre’ και επιλέξτε ΟΚ. 
 
        
 

                     
 
 
 
Στο Virtuoso Analog Design Environment παράθυρο , επιλέξτε Setup -> Model Library. To 
Model Library Setup παράθυρο θα εμφανιστεί. Ελέξτε τα model directories και θα έχετε το ίδιο 
παράθυρο με το ακόλουθο. 
 



 

 
 
 
 
 Στο Virtuoso Analog Design Environment παράθυρο , επιλέξτε Analyses -> Choose και στη 
συνέχεια συμπληρώστε τη φόρμα όπως υποδεικνύεται παρακάτω . 
 
   
 

                          
 
 
 
 
 
 
 
 



Στο Virtuoso Analog Design Environment παράθυρο , επιλέξτε Outputs -> To Be Plotted -> 
Select on Schematic .  Στη συνέχεια επιστρέψτε στο σχηματικό και κάντε κλικ στα καλώδια του 
inverter που αποτελούν είσοδο και έξοδο ( τα σημεία δηλαδή στα οποία θέλετε να κατασκευάσετε 
τις γραφικές παραστάσεις ). Θα επιλεγούν έτσι τα κατάλληλα καλώδια. 
 
 
 

 
 
 
Πατήστε Esc για να φύγετε από το Selection Mode . Τα σήματα πρέπει να έχουν προστεθεί στο 
παράθυρο εξόδου.  
   
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 

        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Στο Virtuoso Analog Design Environment παράθυρο , επιλέξτε Simulation -> Run. Τότε , η 
γραφική παράσταση της εξομοίωσης θα εμφανιστεί στο Waveform Window. 
 
 
 

 
 
 
 
Θυμηθείτε να αποθηκεύσετε τη κατάσταση της εξομοίωσης που κάνατε επιλέγοντας Session -> 
Save State -> OK στο Virtuoso Analog Design Environment παράθυρο. 
 
 
Η εξομοίωση  του schematic έχει ολοκληρωθεί. Αυτό που μένει είναι στη συνέχεια η δημιουργία 
του layout  με τα κατάλληλα εργαλεία και στη συνέχεια η σύγκριση αυτών των δύο ώστε να 
διαπιστώσουμε  αν ταυτίζονται όπως θα έπρεπε ή όχι. 
 
 
 
 
 
 
 
 
 




